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Template Studio 

Overview 

In addition to the Template Library, the Template Studio is used to create and configure templates 

to produce reports automatically, on-demand or both.  Both report templates and form templates are 

created in the studio.  

 

A Report template is used to create and publish reports automatically according to a schedule or on-

demand by a user.  It is a workbook with one or more worksheets that contains: 

• layout of your report using features such as formatting, formula, and charts 

• Report Names for the reports produced from the template e.g., Flow_{MMM}{YY} 

• Data Connect to data servers, e.g., real time, history, or relational database 

• Data Management for advanced processing of the report data 

• On-Demand Designer settings for on-demand reports 

• Schedule settings for automatic reports and publishing  

 

A Data Entry Form template is used for manual data entry. It is a workbook of one worksheet that 

contains: 

• layout of your form using spreadsheet features such as formatting, formula, and charts 

• Data Link to a relational database (managed by the Database Management tool) 

 

Reports are produced from templates using the proprietary reporting engine which takes workbook 

templates to Excel, PDF, and HTML reports without using Excel. 

 

For those unfamiliar with Excel terminology here are the basic terms: 

• An Excel file is referred to as a workbook. 

• A workbook contains one or more worksheets.  Each worksheet appears as a tab at the 

bottom of the workbook. 

• A worksheet contains cells. 

• A collection of cells is a range. 
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Studio Options 

The studio is available as either a ribbon item in Microsoft Excel or in the XLReporter Studio, a 

stand-alone application. 

 

This is determined in the project settings. To access, from the Project Explorer select File, Project 

Settings, Workbook. 

 

 

The studio is opened from the Project Explorer, under the Template Design section by clicking the 

Studio button.  It is also opened by double-clicking any template listed on the left. 

Excel 

The Template Studio is built into Microsoft Excel so templates can harness over 400 functions, charts, 

and formatting capabilities in addition to the XLReporter functions that are specifically built for 

process automation.   

 

This option is available for users who have a licensed copy of Excel and are comfortable in this 

environment.  Since Excel is so universally used, any feature that is unfamiliar can be searched for on 

the internet with hundreds of tips, tricks, and tutorials on how to use it. 

 

 

XLReporter Template Studio 

The XLReporter Template Studio is a stand-alone application where report and data entry form 

templates are designed.  Virtually all the functionality of a workbook is available including functions, 

charts, and formatting in addition to functions that are specifically built for process automation. 
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This option is available for users that do not have a licensed copy of Excel or those that are not as 

familiar with Excel and want an environment that provides that type of functionality but presented in a 

simpler way. 

Offline Development 

In many instances, XLReporter is installed on a machine on the factory floor where it is too busy to 

do development. 

 

In this scenario the templates can be developed offline in the comforts of someone’s office.  If the 

system where development is done has Excel installed, it can be used as the Design Studio.  Then, 

when it is time to deploy, the project can be copied to the runtime system.  If small modifications need 

to be done, they can be done using either the XLReporter Studio or Excel, giving you the best of both 

worlds. 
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Template 

Templates are at the heart of reports.  A template is a workbook file containing one or more 

worksheets that represent the desired report.  The content of a template consists of a layout of standard 

Excel features combined with features provided by XLReporter that are specifically for industry. 

 

When a template is “processed”, the naming convention configured is used to create a report and the 

report is populated with the data from the Data Connections.  After any Data Management, the 

report is saved to XLS, PDF and HTML file formats or sent as an E-mail. 

 

Templates are “processed” from the Scheduler, periodically or on events, from pushbutton clicks on 

an HMI, from VB scripts or on-demand from local or remote workstations.  In every case, a report is 

produced from the template. 

New 

To create a new template, select Template, New (Excel) or File, New (XLReporter Template Studio). 

 

 
 

Enter a Name using only the characters permitted for a file name and a Description (optional).  If the 

project is configured with a Password, select whether to set password protection to the template by 

checking Apply Template Access Code.  For details on setting the Password in the project, see 

SETUP, Implement Project Security. 

 

Set Template Type to Report (the template is used to create reports automatically according to a 

schedule or on-demand by a User), Stacked Report Template (a report template stacked based on the 

results of a database query), or Data Entry (template is used for manual data entry management).   

 

To start with an existing Excel workbook, check the Import Existing Workbook option. 

 

Click OK to create the template. If the import option is selected, you are prompted to select a 

workbook from the file system. Change the layout of the template by using features such as formatting, 

charts, and formulas. 
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Open 

To open an existing template, select Template, Open (Excel) or File, Open (XLReporter Template 

Studio). 

 

 

Double-click a template to load. 

Save/Save As 

To save changes to a template, select Template, Save (Excel) or File, Save (XLReporter Template 

Studio).  To save the template to a different name, select Template, Save As (Excel) or File, Save As 

(XLReporter Design Studio). 

 
 

As part of saving the template, any data groups from the original template that contain the name of the 

template are duplicated, named after the new template, and updated as connections in the new 

template.  For example, if TemplateA has a data group named TemplateA_Daily, if TemplateB is 

created by doing a save as of TemplateA, a data group named TemplateB_Daily is created and updated 

as the connection in TemplateB. 

 

In the XLReporter Template Studio an Auto Save option is available.  When checked, the template 

workbook is saved every few seconds to ensure no work is lost if the application is closed or the 

machine has an issue.  Please note, this option is not enabled by default and the setting is not retained.  

If you wish to enable auto save, you will have to enable it explicitly every time you open the Template 

Studio. 
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Settings 

To access the template settings, select the General button (Excel) or File, Settings (XLReporter 

Template Studio). 

 
The General option is to modify the template Title and Description.  If security is enabled, then the 

user groups permitted to access the template in On-Demand Reports are listed and the Signatures 

options are available. 
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Connect 

Data 

Connect 

The Connect option is used to define the data connections for a report template. 

 

For more information, see DESIGN, Data Connections. 

Manage 

The Manage option is used to define the management functions for a report template. 

 

For more information, see DESIGN, Data Management. 

Link 

The Link option is used to define the relationship between a template and a database for form 

templates.  

 

For more information, see DESIGN, Design Manual Data Entry Forms. 

Source 

Variable 

The Variable option opens the Variable Editor where variables in the project can be added and 

modified.  

 

For more information, see DESIGN, Variables. 

Analytic 

The Analytic option opens the Analytic Editor where analytics can be configured for the project. 

 

For more information, see CONNECT, Analytic Data Logging and Analysis. 

Event Frames 

The Event Frames option opens the Event Frame Editor where event frames can be configured for 

the project. 

 

For more information, see CONNECT, Event Frames. 

Tools 

Database Manager 

The Database Manager option opens the Database Manager application which is used to maintain 

tables and columns in a database. 

 

For more information, see CONNECT, Manage Relational Databases. 
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Design 

The Design tab provides access to all the tools needed to design the report template with all the 

workbook and worksheet features you wish. 

Themes 

The Themes option opens the Theme Builder which is used to maintain report appearance. 

 

For more information, see DESIGN, Template Themes. 

Content 

Insert 

This menu is used for inserting things into the template like cells, worksheets, named ranges, pictures, 

shapes, functions, tables of summary calculations and/or hyperlinks. 

Summary Table 

Use this to insert a table of summary calculations for a given cell range in the worksheet rather 

than add each formula individually on the sheet. 

 
 

 
 

The example above demonstrates how this option can be used to add the Average, Mininum and 

Maximum formulas for each Column from C:F between rows 6:36.  The table of summary 

calculations is put onto the sheet starting cell C38. 

 

Source 

The cell range containing the values to be calculated. If the number of rows (or columns) of 

data brought into the report is unknown and the data connection is configured to insert, only 

the first two rows (or columns) need to be specified. The formulas will automatically adjust as 

each row (or column) is inserted into the sheet (see the Understanding Insert Placement 

section in DESIGN, Data Connections).  
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Summarize 

When summarizing the Source values, this can be done by Columns or by Rows, depending 

on the direction of the data. 

 

Target 

The destination (upper left corner) for the summary table. By default, this will be set to two 

rows beneath the Source range but can be customized. 

 

Calculations 

Several basic summary calculations are provided to choose from, all of which can be selected 

at once. In the worksheet, these will appear in the same order as they do in this list. 

 

Add Labels 

If checked, labels for each calculation are placed in the worksheet. If Columns is selected for 

the Summarize setting, the labels are placed one column to the left of the Target cell. If 

Rows is selected, the labels are placed one row above the Target cell. 

 

Add Borders 

If checked, an outside border is added around the summary table (not including labels). 

Chart 

Anatomy of a Chart 

A common usage of charts is to visualize the data collected by Data Groups. A Data Group has 

several components which influence chart configuration. 

 

 
 

The number of Selected Columns influences the number of series in the chart. 

 

The Output Options for Timestamp on first column and Include Heading influence the charts 

category axis and series names. 
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The number of rows collected into the report by the Data Group also influences the chart 

configuration. In the above example, data is returned at a 1 hour Interval over the Period of the 

Current Day, therefore 24 rows are returned. 

 

 
 

In the above diagram, the data from the example Data Group is mapped onto a line chart. 

 

The Category Column containing the timestamps in purple is displayed as the horizontal axis 

labels. 

The Series values are displayed as the 24 rows of tag data. 

The Header rows returned by the headings included in the Data Group in blue are used in the 

legend. 

 

Empty Chart 

This option is only available in the XLReporter Template Studio. 

 

When selected, an empty chart is added to the worksheet at the currently selected cell.  From here 

the chart can be configured by either right-clicking it or by selecting the Design and Format 

options in the Chart area of the ribbon.  For details, see the Chart Configuration section below. 

 

Express Chart 

This option is available in the XLReporter Template Studio by selecting Express Chart under 

the Chart button (or clicking the Chart button itself).  In Excel, this option is available by 

clicking the Chart button. 

 

Before selecting this option, it is recommended to highlight the range of cells to apply to the chart.  

By doing this ahead of time, in most cases, in the Express Chart all that needs to be selected is 

the chart type itself. 
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The Chart branch on the left displays a list of every available chart to configure.  When a 

Category is selected, each Type of chart for it is displayed.  Hover over any Type to see a 

description of the chart type. 

 

To configure the series for the chart, on the left, select the Series, Data Source branch. 

 

 
 

Header Rows defines how many rows, if any, at the top of the Selected Range are used as labels 

for the chart data series. 

Category Column specifies whether or not the left-most column in the Selected Range is added 

as a series on the Category axis of the chart (if the selected Chart Type supports a category axis).   

 

Some chart types, like line charts, support a category type like Date or Text to define the type of 

data the category axis is comprised of.  If the column contains dates (without times), the category 

can be set to Date, for anything else (include dates with times), this should be set to Text.  Other 

chart types do not have this level of configuration in which case this can set to Yes to treat the 

leftmost column of the Selected Range as the Category axis or No to treat the leftmost column as 

the first series of the chart. 

 

Placement is the cell where the upper left corner of the chart appears initially.  The chart can be 

moved and resized after it is added. 

 

Once the chart is added, in Excel it can be modified and manipulated by using the options 

available in the Chart Design and Format ribbon options that appear when the chart is selected. 

 

In the XLReporter Design Studio, the chart can be modified and manipulated by either right-

clicking it or by selecting the Design and Format options in the Chart area of the ribbon.  For 

details, see the Chart Configuration section below.  
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Chart Configuration 

The following options are available in the XLReporter Template Studio when a chart is selected. 

Data Series 

This option is avaiable from the right-click menu or from the Design button in the ribbon. 

 

 
 

From the Chart branch the overall chart type can be changed by selecting the Category and 

Type. 

 

Each series in the chart is displayed as a branch under Series on the left.  A new series can be 

added by selecting the Series branch and clicking the Add button.  A series can be deleted by 

selecting the specific series branch and clicking the Delete button. 

 

The specific series branch displays general settings based on the chart type. 

 

 
 

The Chart Type branch provides the option to the change the type of the specific series selected 

rather than every series in the chart.   
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Use this option to configure combination chart such as a chart some series are shown as columns 

and others are shown as lines. 

 

The Data Source branch displays where the data for the series comes from. 

 

 
 

The Name can be a fixed name or a cell reference.  Values is the series values and Category axis 

labels are the X-axis. 

 

The Format branch displays information about how the series is formatted on the chart. 
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The settings displayed are based on the Chart Type of the series.  From here things like styles and 

colors can be configured to customize the look of each series. 

 

Chart Area 

This option is avaiable from the right-click menu or from the Format button in the ribbon. 

 

 
 

Use these settings to modify the Font, Fill color and Line options for the chart area. 

 

Plot Area 

This option is avaiable from the right-click menu or from the Format button in the ribbon. 

 

 
 

Use these settings to modify the Fill color and Line options for the plot area. 

 

Legend 

This option is avaiable from the right-click menu or from the Format button in the ribbon. 

 

 
 

Use these settings to show a legend on the chart and choose where it should be positioned.   
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Once shown, use the branches beneath to configure the Font, Fill color and Line options for the 

legend. 

 

Title 

This option is avaiable from the right-click menu or from the Format button in the ribbon. 

 

 
 

Use these settings to configure a Title for the chart. 

 

Once applied, use the branches beneath to configure the text Alignment, Font, Fill color and Line 

options for the title. 

 

Axes 

This option is avaiable from the right-click menu or from the Format button in the ribbon. 

 

 
 

Use these settings to configure the X and Y axes for the chart. For each Axis there are a number of 

different options available to configure how each is displayed in the chart. 

 

Copy Chart 

This option copies the selected chart as a new chart on any worksheet in the workbook. 

 

 
 

The Target setting is the top left corner of the worksheet of where the new chart is copied. 

 

Snap To Grid 

This option is available from the Format button in the ribbon. 
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When selected, if the chart is moved or resized when the mouse is released the chart is resized to 

completely fit the range of cells that contain it. 

 

Consider the following: 

 

 
 

The chart encompasses the range I4:P14 but does not fill the entire range.  By enabling Snap To 

Grid and moving or resizing the chart slightly, the chart now appears as: 

 
 

Note that once the Snap To Grid option is enabled it will take affect every time the chart is 

moved or resized until the option is selected again to shut it off even if the chart is de-selected and 

then selected again. 
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Report 

Report Names 

The Report Names define the name of the report generated from the template.  The naming rule is 

also applied to published PDF files and Web Pages. 

 

Names can be specified at both the workbook and worksheet level.  

 
 

Select Report Names. On the left the workbook settings are available along with the specific 

worksheet names from the template. 

 

All the worksheets in the workbook are listed. Each can have a Report name configured.  The general 

Worksheets folder is the default that when set is used for any worksheet without a specific name. 

 

The masks are a combination of static text, date/time, variables, and name types. 

• Static Text 

Text can be included in any part of the mask. 

• Date/Time  

Date and time formats. 

• Variable 

A Variable, enclosed in {} can be included in any part of the mask provided its value does 

not violate the Windows file naming convention.  The value of the Variable is normally 

assigned before the template is used.  For example, use a custom variable {BatchName} in the 

mask and set the value of {BatchName} to the value of a PLC tag. 

 

The Overwrite setting indicates if the workbook or worksheet exists, it is overwritten.   

 

Select an option to the right row and click Modify to edit the masks. 

 

 
 

The mask items can be selected by clicking the browse […] pushbutton. 
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Schedule 

The Schedule option opens the Schedule Designer where templates can be scheduled to produce 

reports periodically, on time or event. 

 

For more information, see REPORT, Deploy Schedule Reports. 

On-Demand Designer 

The On-Demand Designer is used to configure a template to generate reports on demand.  This 

includes configuring parameters for the user to specify and setting the action(s) necessary to generate 

the report. 

 

For more information, see DESIGN, Design On-Demand Reports. 

Preview 

The Preview option is used to preview the template as a report using the On-Demand Reports 

application. 

 

For more information, see REPORT, Deploy On-Demand Reports. 
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Workbook Features 

The following highlight some features that can be used to help enhance the report template.  These 

features are available in both Excel and the XLReporter Template Studio except where noted. 

Cell Formatting 

Number Format 

Excel 

For custom formatting of cells, right click and select the Format Cells… In this dialog decimal places, 

date formats, currency, percentage, and other options can be specified.  On the Number tab, the 

Custom Category provides more advanced formatting e.g., mm/dd/yy h:mm:ss gives the date and time 

to the second. 

 

XLReporter Template Studio 

For custom formatting of cells, right click and select the Format Cells… With the Format button 

decimal places, date formats, currency, percentage, and other options can be specified.  The Custom 

option provides more advanced formatting e.g., mm/dd/yy h:mm:ss gives the date and time to the 

second. 

 

Borders and Backgrounds 

Borders and background colors can add a level of sophistication to reports. 

 

For Data Entry Forms, placing a border around each input cell is a good idea to emphasize the form 

field.  Different background colors can be used to color code input cells one color and any formula 

cells with another.  

 

Excel 

These settings are available in the Format Cells dialog under the Border and Fill tabs. 

 

XLReporter Template Studio 

These settings are available in the Format Cells option under the Border and Font sections. 

 

Formulas 

There are over 400 formulas and functions that can be incorporated into reports.  To access, click the 

fx button in the formula bar. 

 

For Data Entry Forms, user entry can be values used by formulas in other cells.   Both user entry and 

formulas can be saved to the database.  Note that in order to prevent a formula from being overwritten 

when the form is refreshed, set the Transfer of the cell(s) to Write. 

Data Validation 

All the Data Validation in the workbook can be used in a Data Entry Form. 

 

In Excel, select Data, Data Tools, Data Validation.  In XLReporter Template Studio select Design, 

Data, Data Validation. 

Examples of data validation include restricting cell values to certain ranges and providing pick list for 

the user’s selection.  In addition, custom instructions and error prompts can be configured to give 

feedback to the user.   

 

Most of these validation types require a data type and a condition that must be met.  The condition can 

be hardcoded or given by a cell reference.  

 

Hint: Select the entire range of cells that require the same type of validation before opening Data 

Validation. 
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• Validation Types 

Any Value 

Any input is accepted for this type.  This is applicable for fields in a form that you do not need 

any validation for, however still want to utilize the custom input prompt for providing 

instructions. 

 

Whole Number 

The field can accept a whole number that meets the specific criteria. 

For example, a field can only accept an integer between a min and max value contained in 

cells C10 and C11, respectively. 

Allow:  Whole Number 

Data:  Between 

Minimum:  =C10 

Maximum:  =C11 

 

Decimal 

The field can accept a decimal number that meets the specific criteria. 

For example, a field can only accept a decimal number that is less than or equal to 5. 

Allow:  Decimal 

Data:  less than or equal to 

Maximum:  5 

 

List 

A drop-down list is provided to select from.   It is recommended to use this option whenever 

possible to prevent against manual entry errors and to keep the database entries consistent.  In 

addition, dynamic lists can be created by using formulas. 

With this option, In-cell dropdown should always be checked.  

For example, the field requires one operator name to be entered.  There are 10 total operator 

names that could be chosen.  Their names are listed in cells J1 to J10. 

Allow:  List 

Data:  N/A 

Source:  =$J$1:$J$10  

 

Date 

The field requires a date to be entered that meets the conditions set.   

For example, the field can accept a date that is within today’s date and a week from today.   

Allow:  Date 

Data:  Between 

Start date:  =TODAY() 

End date:  =TODAY() + 7 

 

Time 

The field requires a time to be entered that meets the condition set. 

For example, a time must be entered between normal working hours 9am to 5pm.  

Allow:  Time 

Data:  Between 

Start time: 9:00 AM 

End time:  5:00 PM 

 

Text Length 

The field requires text to be entered that meets the condition set. 

For example, the field is a comment field that requires text but is limited to 255 characters so 

it can be inserted into a Text data field. 

Allow:  Text Length 
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Data:  Less than or equal to 

Maximum: 255 

 

Custom 

The field uses a calculation/formula to determine if data entered is valid.  The formula must 

evaluate to TRUE for valid entries and FALSE for invalid entries.  This is the most dynamic 

of the validation types because it can use a vast array of formulas.  The value of other cells 

can be used to determine validation as well.   

For example, the field configured for cell B10 can only accept text.  Use =ISTEXT(cell) as the 

formula to validate that only text is entered. 

Allow: Custom 

Formula: =ISTEXT(B10) 

 

In another example, the cell A11 can only accept a product ID starting with “PROD” and 

ending with a number. E.g., PROD459789. 

Allow: Custom 

Formula: =IF(LEFT(A11,4)=”PROD”, TRUE, FALSE) 

 

• Ignore Blank 

Most validation types offer the Ignore blank option which is found in the Settings tab.  To 

ensure the user must enter a value, uncheck this option.  When the form is deployed, the cell 

will appear with a red background when the form is deployed until data is entered.   

 

If you wish to create a required cell with no additional validation, set Allow to Any Value.  

However, the Ignore blank option is disabled.  To work around this problem: 

• Switch Allow: to Whole Number. 

• Uncheck Ignore blank. 

• Set Allow: back to Any Value.  

 

• Custom Input and Error Messages 

As part of the validation configuration, custom input and error messages can be set.  These 

messages appear when the cell is selected or when data entered in the cell does not meet the 

validation configured.  By creating input messages, you can give the user instructions on each 

form input as well as instructions to correct the data if it does not pass validation. 

Input Message 

This option, when enabled, displays a prompt when the user selects the cell to edit.  It can be 

used to give instruction on what type of data is required for this field.   

 

Error Alert 

This option (when enabled) prompts the user after invalid data is entered in the cell to alert 

them that it is invalid.  In Data Entry Forms only the Stop Style is supported, the others 

should not be used.  When invalid data is entered, a Stop alert message is shown.  There are 2 

options available: 

• Retry to enter a new value 

• Cancel to remove the current value from the cell 

 

If this option is not enabled and the user enters invalid data, the data remains in the cell.  This 

can be useful for cells that present a list of values to select from but also allow for the user to 

enter something manually.  For example, on a form a user must fill out if a piece of equipment 

fails, a list of common failure reasons may be provided, but there may also be the need for a 

user to enter a custom reason that is not on the list. 
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Conditional Formatting 

One of the best features of workbooks is conditional formatting which highlights anomalies or values 

that are “out of spec”. 

 

To configure in Excel, under the Home tab select Styles, Conditional Formatting, New Rule.  For 

example, to color a cell red if the value is greater than 50, Select Format only cells that contain.  For 

the Rule, set Cell Value greater than 50.  Click Format and under Fill, select red. 

 

To configure in the XLReporter Template Studio, under the Design tab select Content, Conditional 

Formatting, Manage Rules.  

Named Cells/Ranges 

Providing a name to a cell has the benefit that if rows/columns are added/removed, the name always 

remains with the cell.  This means that if a data connection uses a named cell, the data from the 

connection is placed at the current location of the cell.  This is in contrast with a connection that uses a 

specific location e.g., $B$8, which always places its data to the specific cell. 

 

Take, for example, a report template set up with 2 data connections where the number of rows returned 

for each connection is unknown during template design. 

 

 
 

The connections are configured to insert with one connected to cell $B$4 and the other to ABC which 

is a named cell for $B$10.  The connection at $B$4 inserts its data pushing the name ABC down the 

worksheet.  The connection at ABC now starts below the entire data table of the top connection. 
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Named cells can be used in both Data Connect and Data Manage.  To use a named range, the Scope 

(Data Connect) or Active By (Data Manage) setting must be set to a specific worksheet. 

 

Then in the settings where a cell reference can be specified (like Placement for Data Connect), toggle 

from Cell to Name.  A drop-down list of all configured named ranges configured for the selected 

worksheet. 

Defining a Named Range 

Excel 

Named cells/ranges are defined in Excel a few different ways.   

• Under the Formulas tab, in the Defined Names section, click Define Name. 

• Under the Formulas tab, in the Defined Names section, click Name Manager.  In Name 

Manager click New. 

• With the cell/range to name highlighted in the worksheet, click into the Name Box to the left 

of the Excel’s formula bar, enter a Name (replacing the cell reference shown) and press the 

Enter key. 

 

XLReporter Template Studio 

• Under the Design tab, select Content, Insert, Named Range. 

• Under the Design tab, select Data, Name Manager. 

LastCell 

Special consideration is made for any connection configured to a cell named LastCell.  LastCell should 

only be used with connections that have Placement set to one of the Insert types. 

 

When a connection configured to LastCell is updated, cells/rows/columns are inserted (depending on 

Type and Direction) causing the LastCell definition to move down or across the worksheet.  This 

functionality can be useful for reports where multiple rows/columns of data are brought into the report 

at different times, and each appears beneath / to the right of the previous. 
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Inserting Cells, Rows and Columns 

On a worksheet cell, rows and columns can be inserted shifting the existing content of the worksheet.  

However, different insertion methods net different results. 

Inserting Entire Rows 

In the XLReporter Template Studio, insert a row by selecting an entire row and selecting Insert, 

Rows. 

 

When an entire row is inserted into a worksheet every row starting at the row selected and below is 

shifted down by 1 row.  This includes: 

• Cell Content and formatting 

• Charts 

• Images 

• Row Heights 

Inserting Entire Columns 

In the XLReporter Template Studio, insert a column by selecting an entire column and selecting 

Insert, Columns. 

 

When an entire column is inserted into a worksheet every column starting at the column selected and 

to the right is shifted to the right by 1 column.  This includes: 

• Cell Content and formatting 

• Charts 

• Images 

• Column Widths 

Inserting Ranges 

When a range is inserted into the worksheet you have the option of shifting cells right or shifting cells 

down.  However, this only affects cells within the range inserted. 

 

For example, with cell $B$4 selected if you insert shifting cells down, anything in the B column 

starting at 4 is shifted down by 1 row.  Nothing else is affected.  Unless charts and images are 

contained completely within the B column they will not be shifted down.  In addition, row heights are 

not shifted down either. 

Usage with Data Connections 

As part of template design, Data Connections (as well as some Management) can be configured to 

insert cells, rows or columns depending on the Placement Type specified. 

 

The Insert At Start and Insert At End types perform a range insert on the worksheet, shifting cells 

either down or to the right depending on Direction.  The Insert At Start (full) and Insert At End (full) 

types perform full row or column inserts on the worksheet shifting all rows down or columns right 

depending on Direction. 

 

To illustrate the behavior, consider the following scenario: a template with a single connection that 

returns 5 columns and 24 rows configured to cell $B$4. 

 

If this connection is set up as Insert at Start with Direction Down, when it runs it inserts a range of 5 

columns by 24 rows into worksheet.  This means anything in the B – F columns below row 5 is pushed 

down the worksheet.  Nothing else is affected. 

 

The benefit of this configuration is that anything set up to the right of the connection is not affected by 

the insert of this connection so a second connection could be easily configured to the right and nothing 

else would have to be considered. 
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If this connection is set up as Insert at Start (full) with Direction Down, when it runs it inserts 24 full 

rows into worksheet.  This means anything in any column below row 5 is pushed down the worksheet. 

 

The benefit of this configuration is that if anything is set up below the connection that is “wider” than 

what the connection returns, it is shifted down and not displaced.  In addition, objects like charts and 

images which may not fit exactly under the range of the connection are shifted down as well along 

with any custom row heights that may be configured. 

Excel Considerations 

When using Excel as the Template Studio, the following should be considered. 

 

Saving Templates 

When a template is saved, use the Template, Save option since this saves the workbook and compiles 

a list of worksheets in the workbook for other uses. 

 

Copying an Existing Template 

To create a new report template from an open template, use the Template, Save As option since this 

saves the workbook and the configuration to the new template. 

 

Adding/Deleting Rows and Columns 

Use the Cells, Insert/Delete option to insert or delete rows or columns so that changes in the position 

of cells also affect the data connections. 

 

Comments 

By default, when a data connection is configured, a comment is added to the target cell.  The comment 

appears as a red mark in the upper right-hand corner of the cell and can be removed if desired. 

 

In Data Connections set Auto Comment to No to turn comments off. 

Design Considerations 

When designing in either environment, the following should be considered. 

 

Renaming Worksheets 

If a worksheet is referenced by data connection, renaming the worksheet invalidates the connections.  

In such cases, use the Export function provided in Data Connection, replace the old worksheet name 

with the new one and then use Import to update the configuration. 

 

Printing Reports and Forms 

When a report or form is printed, the page layout defined in the studio is used for the worksheet.  

These settings are accessible under the Page Layout tab in Excel and File, Print, Page Setup on the in 

the XLReporter Template Studio. 

 

These page settings extend to the report when it is published as a PDF file. 

 

Print Area 

By default, when a worksheet is printed, every populated cell appears on the printout.  The Studio 

provides an option to set the print area of a worksheet so that only a specific range of cells appears on 

the printout.  This can be defined for each worksheet by highlighting the cells to print and selecting 

Page Layout, Print Area in Excel and File, Print, Page Setup in the XLReporter Template Studio. 
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Security 

Reports viewed using the Report Viewer, both locally and with a Team Client, are read-only.  If 

manual edits are to be permitted, then the cells in the template need to be unlocked.  To unlock a cell in 

Excel, right-click and select Format Cells.  In the Protection tab, uncheck Locked.  To unlock a cell 

in the XLReporter Template Studio, select the cell(s) and click the Format dropdown list on the 

Design tab and choose Unlock Cells. 

 

This security is applied to on-demand reports that are generated using the On-Demand Reports 

application. 

 

The same security is extended to Form Templates so any cells that user must enter data into should be 

unlocked. 

 

In addition, any cell containing a formula is automatically protected against editing regardless of 

whether any security is applied to the report. 

Formulas and Functions 

As previously mentioned, there are over 400 formulas and functions that can be incorporated into a 

report template.  To access, click the fx button in the formula bar. 

Parameters 

A formula can have one or more parameters that define the value returned to the cell.  A parameter can 

be a hard coded value or a cell reference (or range).  When a cell reference or range is specified, it can 

be done as an absolute reference, a relative reference, or a mix of both. 

 

Absolute Reference 

An absolute reference means that the cell or range is locked so that if the cell is copied the reference 

will not change.  An absolute reference is denoted with “$”, e.g., $A$1 or $A$1:$C$5. 

 

Relative Reference 

A relative reference means that the cell or range changes if the cell is copied.  A relative reference is 

denoted without “$”, e.g. A1 or A1:C5. 

 

Mixed Reference 

A mixed reference means that either the column or row is locked but the other is not so if the cell is 

copied only the unlocked reference is changed.  For example, $A1 means that the column (A) is 

absolute while the row (1) is relative.  Conversely, A$1 means that the column (A) is relative while the 

row (1) is absolute. 

 

A Practical Example 

Consider a report template that brings in product codes from 4 different lines and contains a lookup 

table to determine the name of the product based on the code. 

 

To show the product name along with the product code, a LOOKUP formula can be used.  Let us 

assume that the product codes are to be written to cells C4, D4, E4 and F4 and the corresponding 

names in cells C5, D5, E5 and F5.  The lookup table is in cells AA2:AB51. 

 

In cell C5, the formula should be: 

=LOOKUP(C4, $AA$2:$AB$51) 

 

The LOOKUP function has two parameters:  the first is the value to look up and the second is the 

range of the table to use for looking up.  Notice that the first parameter is set as a relative reference and 

the second parameter as an absolute reference.  This is so the formula can be copied from C5 and 

pasted into D5, E5 and F5 without making any edits.  The first parameter will change but the second 

will not. 
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Useful Functions 

While it would be impossible to document all the functions available in the studio, the following are 

ones that can help in reporting. 

 

IF 

The IF function is used to compare values and show a different value based on the comparison being 

true or false. 

 

A common use of this would be that if a measurement is less than a threshold (like 0.1) show is as 

“N/A”, otherwise show the value.  If the value is in cell A1, the formula is: 

=IF(A1<0.1, “N/A”, A1) 

 

The first parameter is the comparison, the second is the value if the comparison is true and the third is 

if the comparison is false. 

 

IFERROR 

The IFERROR function is used to check if there is an error and if so, do not show the error but instead 

show what is specified. 

 

A good example of this is using this function in conjunction with the AVERAGE formula so that if all 

the cells are empty, #DIV/0! is not shown.  If the average spans the range A1:A23, the formula is: 

=IFERROR(AVERAGE(A1:A23), “”) 

 

The first parameter is what to test for an error.  If this is not an error, the value from the parameter is 

used.  However, if the value from parameter 1 is an error, the value in parameter 2 is shown.  In this 

case, the cell will appear empty. 

 

COUNTIF 

The COUNTIF function can be used to count values in a range that meet the criteria specified.  The 

criteria can be hard coded like “>25” or “<1” or a cell reference.  If a cell reference is specified on its 

own, this means that the criteria operator is equals.  For any other operator it must be concatenated 

with the cell reference.  For example, if the criteria is greater than the value of cell A1, it must be 

specified as “>” & A1. 

 

For example, if cells C4:C50 contain temperature readings and the report needs a count of how many 

times the temperature exceeded 100 degrees the formula is: 

=COUNTIF(C4:C53, “>100”) 

 

SUMIF and AVERAGEIF 

The SUMIF and AVERAGEIF functions are very similar to the COUNTIF function in that a range and 

a criteria is specified to derive a value.  However, both functions have an optional third parameter 

which is the range to perform the calculation on. 

 

For example, let us say the B column contains the state 0 or 1 and the C column contains temperature 

in rows 4 to 53.  To get the average temperature only when the state is 1, the formula is: 

=AVERAGEIF(B4:B53, “>0”, C4:C53) 

 

MATCH 

The MATCH function is used to find the matching row or column where a specified value is located. 

 

For example, if the report contains hourly values from cells C4:C27 and in cell C29 the maximum of 

that range is determined (using the MAX function), the MATCH formula can be used to determine 

which row in the range contains the maximum.  The formula is: 

=MATCH(C29, C4:C27, 0) 
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This in and of itself may not be very useful, however, if the B column contains the timestamps 

corresponding to those values, the OFFSET function can be used with the MATCH function to get the 

time of maximum for the day.  The formula for that is: 

=OFFSET(B4, MATCH(C29, C4:C27, 0)-1, 0) 

 

Note the -1 at the end of the MATCH formula.  This is because the OFFSET formula is 0 based and 

the MATCH formula is 1 based. 

 

MID 

The MID function is used to extract characters from text.  A good example of this would be a report 

where a code is retrieved that has multiple elements that need to be broken out within the report.  For 

example, if the code is brought into cell B4 and the 4th and 5th characters need to be extracted, the 

formula is: 

=MID(B4, 4, 2) 
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Information in this document is subject to change without notice.  SmartSights, LLC assumes no 

responsibility for any errors or omissions that may be in this document.  No part of this document may be 

reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without 

the prior written permission of SmartSights, LLC. 
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